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1. INTRODUCTION 

East Nile Flood Forecasting and Early Warning system development project is the continuation 

of previously implemented flood forecasting system for Blue Nile watershed. The existing flood 

forecasting system consists of different software components that do not communicate well 

between one another and had issues with real time application. The East Nile watershed has 

4 sub watersheds and each sub watershed has different models for producing forecast.  The 

project herein build a unified forecasting model utilizing the software suit (MIKE Family) by DHI 

This software suit has been in used successfully for number of years in the and there may be 

many other places the suite has been used already. 

The scope of the project is to develop an Early Flood Forecasting System (EWFFS) to four sub-

basins of the Eastern Nile basins, namely Lake Tana, Blue Nile, Baro Akobo Sobat and Atabara 

Tekeze-setit. The development of EWFF system include the following tasks: 

1. Sourcing of different data (e.g. climate, Digital Elevation Model (DEM)) 

2. Development of Rainfall-runoff model for the four sub-basins of the Eastern Nile basin. 

3. Development of hydraulic model for the four sub-basins 

4. Integration of developed models into an EWFFS platform 

5. Automate the EWFFS to send Flood Warnings when the system predicts possible flood 

 

 
 

                                                             Figure 1.1: The Eastern Nile Basin and sub-basins 
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1.1 OBJECTIVES 

The objective of this project is;  

•To ensure a robust forecasting, issuing and warning system that effectively minimize loss of life 

and damage by enhancing, expanding and developing a unified Flood Forecast and Early 

Warning (FFEW) system for EN basin   

•To support other studies under FFEW that contribute in addressing flash flood, stakeholder 

analysis and flood related DSS development.   

1.2 DELIVERABLES 

The deliverables of the project are as stated below: 

• Task 1 deliverables are: 

o Inception report on  

o Review and gap analysis on the current system 

o Review of best practices 

o Gather, review, analyses and process data for use in building of hydrological 

models for the Blue Nile, Main Nile, Lake Tana, Baro-Akobo- Sobat and Atbara-

Tekeze-Setit systems under a unified modelling platform 

o Work with the team leader and other team members and submit a document 

with the models proposed methodology and list of models(hydrological, 

hydraulic and flood forecast system) with work plan 

• Task 2 deliverables are: 

o Set-up and calibrate and validate hydrologic model for Blue Nile, Lake Tana, 

Baro-Akobo-Sobat and Tekeze-Setit-Atbara sub basin flood prone areas 

o Set-up and calibrate and validate hydraulic/hydrodynamic  models for Blue 

Nile, Lake Tana and Baro-Akobo-Sobat 

o Set-up a forecasting system for integration of forecast models and easy 

dissemination of forecast results 

• Task 3 deliverable are: 

o Test the hydrological, hydraulic models for Blue Nile, Lake Tana ,Baro-Akobo-

Sobat and Atbara-Tekeze-Setit systems  

o Prepare floodplain inundation maps for each of the Flood prone areas in the 

Eastern Nile basin at various flood levels and various return periods 

o In collaboration with the Web expert and IT unit make hydrodynamic model 

outputs (water level, inundation and impact maps) available to integration with 

the ENTRO portal/website  



 

 

o In collaboration with the Web expert and IT unit test the integration of the 

forecast system with ENTRO portal/website 

• Task 4 deliverables are: 

o Design and provide at least two necessary trainings and capacity 

development for sustainable operation of the flood forecast early warning 

system 

o Conduct at least one validation workshop 

o Participate and present in consultation workshops 

o Prepare relevant reports and prepare relevant section of modelling reports and 

user’s manual 

o Other tasks requested by Senior FFEW Expert  

o Support procurement process of necessary equipment and software, in 

collaboration with the other team members and support the setting-up of the 

forecast models on the workstations 

1.3 EASTERNILE EWFFS TRAINING 

The purpose of this document is to facilitate the training process of the EasterNile EWFFS (Early 

Warning Flood Forecasting System). The initial chapters follow training guidelines, in order for 

the participants to get familiar with various processes of how the EasterNile EWFFS was created. 

These include relatively simple examples, which the trainer will go through with the participants 

and at the end of these chapters are exercises for the participants to complete. This document 

incorporates the following chapters: 

o How to set up a 1D model: participants will learn how a 1-dimentional model is 

created, followed by exercises for them to complete. 

o How to register a 1D model in MIKE Operations Workbench: participants will 

learn how a model is imported into MIKE Operations Workbench. 

o How to setup a MIKE Operations configuration: using the imported model, 

participants will learn how to configure various setups within the MIKE 

Operations application. 

o BlueNile EWFFS: using what they have learned from the above sections, 

participants will be taken through the actual configuration of the BlueNile 

EWFFS configuration in MIKE Operations. 
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2. How to setup a 1 Dimensional Model 

2.1 INTRODUCTION 

The name of the 1-dimensional model setup used within the Early Warning Flood Forecasting 

System (EWFFS) is called MIKE 11.  MIKE 11 is a tool developed by DHI, for simulating hydraulics, 

water quality and sediment transport in estuaries, rivers, irrigation systems and other inland 

waters. The hydrodynamic module of MIKE 11 uses an implicit finite-difference scheme to 

calculate unsteady flow described by the Saint-Venant equations of conservation of mass and 

momentum. The scheme is independent of the wave approximation chosen (kinematic, 

diffusive, or dynamic wave), where a computational grid of Q-points and h-points is used. The 

topography of the river network is defined using cross-sections and the bed resistance 

calculation can be done using the Chezy or Manning equations. Cross-sections constitute h-

points, between which a Q-point is introduced. MIKE 11 handles looped as well as dendritic 

systems, backwater effects, flows in flood plains, as well as a wide range of control structures 

such as pumps, weirs, or controllable gates.   

The HD module is the nucleus of the MIKE 11 modelling system and forms the basis for most 

modules including Flood Forecasting, Advection-Dispersion, Water Quality and Non-cohesive 

sediment transport modules. The MIKE 11 HD module solves the vertically integrated equations 

for the conservation of continuity and momentum, i.e. the Saint Venant equations. For the 

purpose of this training, we will focus on the hydrodynamic (HD) module of MIKE 11, whereby 

a simple model will be created and run. 

2.2 STEP BY STEP HOW TO SETUP A SIMPLE 1 DIMENSIONAL MODEL IN MIKE 

11 

Within MIKE 11, in order to setup a HD model, four files are required. These include: 

o Network file 

o Cross-section file 

o Boundary file 

o Hydrodynamic (HD) parameters file 

In the following exercise, you will learn how to run a simple MIKE 11 HD model. 

2.2.1 Getting Started 

Before the four individual files are created above, the MIKE 11 simulation file needs to be 

created. This is the file that is used to define the type of modules to include (in this case it will 

only be HD). It also houses the four HD files, where the start and end date of the simulation is 

defined, and where the results are stored. To create a MIKE 11 simulation file (*.sim11), do the 

following steps: 

o Open MIKE Zero (Start menu) 

o Click on File > New > File…(or click on the white paper icon) 



 

 

o In the New File window, click on the MIKE 11 folder on the left, then click on the 

‘Simulation  (.sim11)’ file on the right (see screenshot below). 

 

 

o A new sim11 file should now be open. Before continuing, save this file in an 

appropriate location on your PC (File > Save As…) with an appropriate name 

(e.g. BlueNile_demo.sim11). See screenshot below. 

 

Now that the simulation file has been created, we will begin creating the four HD files. Firstly, 

the river network file. 
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2.2.2 Network file 

o Similarly to creating the sim11 file in the previous exercise, open MIKE Zero and 

select the ‘River Network (.nwk11) file.  

o In the ‘Map Projection and Working Area’ box that appears, insert the map 

projection and extent information that is shown in the screenshot below. For the 

map projection, you may have to select Browse…from the dropdown menu, 

then click the Find button and type in “WGS_1984_UTM_Zone_37N”, to find the 

same projection as shown below. Once found, select it and click OK. Click OK 

again on the Map Projection and Working Area window. 

 

 

o Before continuing, save the network file in the same folder as the sim11 file. 

o To manage the background layer files, open the Layers > Add/Remove… menu 

and import the following files from the folder provided (in the folder called 

“Additional”): 

o BlueNile_River.shp 

o BlueNile_photo.bmp 



 

 

 

From the ‘Layers’ > ’Properties…’ menu change the layer-properties: 

o For the image file, change the following co-ordinates: 

▪ Lower left corner: X = -336555.143; Y = 249574.361 

▪ Upper right corner: X = 115073.715; Y = 1754014.659 

▪ Change the Image Map projection to the same as the network file 

These coordinates need to be inserted in order for the background aerial image of the BlueNile 

to be visible.  

o For the “BlueNile_River.shp’, change the line colour to red and the thickness to 

0.3 (see screenshot below). 
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o If the river shapefile is not visible, it may be positioned beneath the aerial photo. 

To change the drawing order, click Layers > Add/Remove… , and click on the 

Overlay Manager tab. Select the shape overlay file and click the down arrow 

(as seen in the screenshot below). Then click OK. 

 

  



 

 

 

You should now see something similar to the figure below, where the river shapefile is now 

drawn on top of the aerial photo. 

  

o Save the nwk11 file again.  

o Now go back to the sim11 file you created initially, and link the nwk11 file you 

just created by browsing for it under the Input tab (as shown in the screenshot 

below). 
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2.2.3 Network digitisation 

The River network can be defined in one of the following two ways (only apply one of the 

methods): 

o Manual Digitisation (slowest method!):  

Starting at approx. x-y coordinates of (15103.785, 1266040), roughly digitise the BlueNile River 

from the upstream end down to the end-point around coordinates (-201301.71, 1734134.5). 

Digitisation can be made on top of the red line of the shape file previously defined. This 

digitizing process is done using the ‘Add new points’ ( ) and ‘Define branch ( ) tools. You’ll 

notice that this process is very tedious and inaccurate. Delete the branch you just created. 

 

o Automatic generation of network from shape file (Fastest and easiest!) 

Select ‘Network’ >’Generate Branches from Shape files…’. 

Select the option; ‘Generate points and branch’ and use the BlueNile_River.shp shapefile. 

Select the appropriate River name attribute (RiverName) and TopoID attribute (Topo_ID = 

‘TopoID’) and press OK (see screenshot below). 



 

 

  

o The upstream point must defined as chainage 0 m and the downstream point 

as chainage 723103 m. 

o HINT: Change the point properties to ‘User Defined’ by opening the network 

Tabular View or double-clicking on the point in the graphical view (as shown in 

the screenshot below).  

o Save the network file. 
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2.2.4 Cross-sections 

Ideally, river cross-section information would be obtained from an accurate digital elevation 

model (DEM) or from LiDAR data (this can be done using another product by DHI called MIKE 

Hydro). Alternatively, data obtained from manual river cross-section assessments would be 

used to insert at various positions along the river branches. However, for the purpose of 

creating a simple 1D model, a different method could be used. This involves creating one 

cross-section at the upper-most end of the branch (BlueNile chainage 0 m) and the lower-

most (BlueNile chainage 723103.25). Thereafter, interpolating cross-sections in-between these 

at constant intervals. 

Note: a more accurate cross-section file has been provided, where cross-sections have been 

obtained from ENTRO. 

To interpolate in-between cross-sections, follow these steps: 

o Create a river cross-section file (.xns11). Save it in the same location as the rest 

of the files that have been created.  



 

 

o Now go to the already-opened simulation editor (sim11), and browse for this 

cross-section file zas input into the sim11 file (like you did for the nwk11 file 

earlier).  

o Click on “Edit...” next to the network file in the simulation editor (see screenshot 

below) to open up the network file 

 

 

o Zoom to the upstream point (BlueNile chainage 0 m), If there is no cross-section 

at the chainage and right-click on it, then scroll to Insert > Network > Cross-

section (see screenshot below).  

o This opens up the cross-section file that was created earlier from the simulation 

editor. The purpose of inserting a cross-section this way is that the branch name 

and chainage number are automatically inserted for the cross-section. 

  

o Now within the cross-section editor, insert the following information for BlueNile 

at chainage 0 (left columns in table below), so that the cross-section looks like 

the one in the screenshot below. 
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River BlueNile 

Ch. 0 m 

River BlueNile 

Ch. 206374 m 

X [m] Z [m] X [m] Z [m] 

0.00 32 0.00 4 

50 29 100 2 

100 27 200 1 

150 26.5 300 0.5 

200 26 400 0.25 

250 26.5 500 0 

300 27 600 0.25 

350 29 700 0.5 

400 32 800 1 

  900 2 

  1000 4 

 

  

o Once the cross-section for chainage 0 m has been inserted, right-click on it and 

select Insert… (see screenshot above). In the small ‘Insert branch’ window that 

appears, insert the downstream chainage number 206374 in the space for ‘First 

chainage’ (see screenshot below). Click OK. 



 

 

  

o Now insert the cross-section information in the right-hand columns from the 

table above. 

o Ensure that the markers 1, 2 and 3 look the same by clicking the ‘Update 

markers’ button (see screenshot below). This assigns a bank marker to the left-

most (1) and right-most (3) points, along with the lowest (2) point.  

  

o Now that we have the cross-sections for the upper and lower-most points on 

the river branch, it’s time to interpolate cross-sections in-between these.  

o To do this, right-click on the 0 m chainage and select “Insert interpolated…”.  

o Select the ‘Multiple sections’ radio button, and specify 0.00 as ‘From existing 

cross section’, and 206374.00 as ‘To existing cross-section’. Specify the ‘With 

max. distance value to be 10000 m, and check the ‘Calculate processed data’ 

box (see screenshot below). Click OK. 
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o You will now notice several cross-sections now added to the cross-section 

editor, where the        symbol ‘*’ indicates that the cross-sections have been 

generated from an interpolation process. 

o •Click on the ‘View Processed Data…” button to see the data for each cross-

section, where the dropdown menu at the top of the screen allows you to see 

various types of processed data. (see screenshot below).  



 

 

 

 

o Click Save to save the cross-section editor. Then click on the small grey cross at 

the top-right corner  

( ) to close the cross-section editor. 

o You will now notice that all the cross-sections that have been created, are 

symbolised by the red and white squares within the network editor. (See 

example in the screenshot below). 
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2.2.5 Boundary Conditions 

Within MIKE 11, a boundary condition needs to be specified at every open branch end. In the 

case of the model we are creating, one boundary condition will need to be specified 

upstream (chainage 0) and one downstream (chainage 723103.25).  

Upstream boundary condition 

o Create a Boundary Condition (.bnd11) file from MIKE Zero, within the MIKE 11 

category folder.  

o Save it in the same folder you have been using for all of the other MIKE 11 files, 

then close the boundary file. 

o Go to the simulation editor (sim11) and browse for this bnd11 file under the 

Boundary data section. You should now have the network, cross-section and 

boundary files all selected from within the simulation editor. 

o Similarly to how a cross-section was inserted at chainage 0, within the network 

editor view, right-click on the upstream point, and select Insert > Boundary > 

Hydro Dynamic.  



 

 

o The boundary condition editor will open. Remove the default line (first one at 

the top), by selecting it and pressing the Delete button on your keyboard. 

o For the BlueNile chainage 0 boundary, click on the browse button   below the 

description, next to the Discharge (Data Type) and time series file (TS Type), and 

locate the “Roseres_Dam_Release.dfs0” file from the folder provided (in the 

folder called “TS”), then click OK. 

 

 

Downstream boundary condition 

o Now click on the Window menu at the top of the screen (which enables you to 

toggle between the other MIKE 11 files that may be open) and click the nwk11 

file to go back to it (See screenshot below).  

  

o Insert a Hydro Dynamic boundary at the lowest point on the branch, then click 

the Window menu to go back to the boundary condition editor.  

o In the newly added boundary, click the dropdown menu under ‘Boundary 

Type’ and select ‘Q-h’. (See screenshot below). Generate the Q/h relationship 

using “Auto-calculation of Q-H Table”.  
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o Now save the boundary condition file and close it by clicking on the small grey 

X. 

2.2.6 Hydrodynamic parameters 

o Create a MIKE 11 HD parameter file (.hd11) and save it in the same folder as all 

the rest of the MIKE 11 files on your PC. 



 

 

o Within the simulation editor, browse for this HD parameter file, so that all four 

files for a MIKE 11 HD simulation are selected. 

o Click on the edit button and click on the ‘Bed Resistance’ tab to change the 

global Manning M number to 30 (See screenshot below). Save and close the 

HD parameter file. 

 

 

2.2.7 Simulation parameters – run a simulation 

o Ensure that all four MIKE 11 files (except the sim11 editor) have been saved and 

closed, by clicking on the Window menu to see if any of them are still open. 

o Within the simulation editor, click on the Simulation tab and specify the 

following: 

▪ Fixed time step: 30/15 sec 

▪ Simulation start: 2019/06/30 

▪ Simulation end:2019/07/30 

▪ Initial conditions: Parameter File (see screenshot below) 
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o Click on the Results tab, and specify the results to be stored in a “Results” folder 

in the same directory as all the other MIKE 11 files. Set the storing frequency to 

be every 1/6 hours. 

o Now click on the Start tab, and run the simulation using the MIKE 11 Classic 

engine. 

2.2.8 Analysing Results using MIKE View 

MIKE View is an application used to analyse the results from a MIKE 11 simulation.  

o Open MIKE View from Start > MIKE View 2019/2020 > MIKE View. MIKE View is a 

program used to load MIKE 11 results in *.res11 format. (MIKE View can also be 

used to open *.res1d files if the new MIKE 1D engine has been used.) 

o As the MIKE View application is opened, browse to the folder where the results 

were saved and click “Open”. Leave the default Data Load Selection as it is, 

and click OK (see the resulting res11 view in the screenshot below). 



 

 

 

 

o Make Time series Plots: 

▪ Look at different result items at different locations (WL, discharge) 

▪ Add multiple time series to one time series Plot 

▪ Show values (which can be used to copy data into Excel) 

▪ Investigate the pop-up menu options by right-clicking the mouse button 

in the horizontal plan view 

o Make Longitudinal plots: 

▪ Change plot settings  

▪ Investigate the popup menu options by right-clicking the mouse button  

▪ Add multiple result items to the same longitudinal plot 

▪ Multiple Areas plots  

 

o Animate simulations: 
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▪ Start animation with multiple plots open 

▪ Change animation settings 

o Save Layouts (for re-using the same layout when opening new result file): 

▪ oWindow Layout 

▪ oComplete Layout 

o Calculate ‘Depth’ and ‘Flood’: 

▪ Use the internal tools in MIKE View to calculate the ‘Depth’ and ‘Flood’ 

results (if not  already calculated). 

▪ What are Flood and Depth values as calculated by MIKE View? 

▪ Make a Longitudinal plot of flood in the BlueNile River.  

  

And just play around to become familiar and experienced in using MIKE View.  

You might even find the fish!   



 

 

2.2.9 Rainfall-Runoff (NAM) 

The Rainfall-Runoff will be demonstrated in the BlueNile EWFFS and please proceed to Exercise 

1. 

There is a similar setup to the one from above, with the addition of an extra river branch. The 

reason for the additional branch is to demonstrate how the rainfall-runoff component of the 

MIKE 11 configuration works. 

Within the simulation editor, the addition to the models tab is the Rainfall-Runoff model, where 

previously it was only Hydrodynamic. See the screenshot below where this is now included. 

  

The following steps are how one would create a rainfall-runoff (.rr11) file to include this model 

within the hydrodynamic one. 

o Similarly to the other files that were created, a “RR Parameters (.rr11)” needs to 

be created and saved in the same folder as all the other files. Thereafter, 

browse for it in the Input tab, so that there are now 5 files included (see 

screenshot below). 
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o Edit the rr11 file, so that you see it open. Click on ‘Insert catchment’ and type 

in the following (screenshot provided), then click OK: 

▪ Catchment name:  Y40D 

▪ Rainfall runoff model: NAM (the default) 

▪ Catchment area: 4536 (km2) 

  

Now that we have our catchment name with the size of it defined, we need to edit the 

parameters for the surface-rootzone and groundwater, along with inserting the rainfall and 

evaporation time series data. 

o Click on the tab called ‘NAM’, where you’ll see Surface-Rootzone tab 

displayed.  

o Here you see a list of descriptions for each of the parameters required (press F1 

on the keyboard to find out additional information). 



 

 

o Insert the various surface-rootzone parameters as you see in the screenshot 

below: 

  

o Next, click on the ‘Ground Water’ tab. Here you see a list of descriptions for 

each of the parameters required (press F1 on the keyboard to find out 

additional information). 

o •Insert the various ground water parameters as you see in the screenshot below 

(only for TG and CKBF): 
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o Next, click on the Timeseries tab. This is where the rainfall and evaporation data 

are selected. 

o For Rainfall, browse to the TS folder provided and select the time series file 

called “NOAA_Rain_Y40D.dfs0”. 

o Similarly, for evaporation, browse to the same TS folder and select the 

“Y40D_Evap.dfs0” file. You should now have a screen similar to the one below: 

  

o Click on Save, and close the RR window by clicking on the small ‘X’ button (top 

right). 

Now that the rainfall-runoff file has been configured, it needs to be linked up to the 

network file in MIKE 11. This is done by following these steps: 

o Within the simulation editor, click on Edit for the network file to open. 



 

 

o Now within the network editor, you’ll notice that there is now an additional river 

branch (called ‘Mazimechopes’), as you can see in the screenshot below. 
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o Open up the tabular view, either by clicking on the View menu and selecting 

‘Tabular View…’, or by pressing Ctrl+T on the keyboard. 

o Expand the Network menu and select Branches. Here you see a summary of 

the branches included in the model, where the names, upstream and 

downstream chainage numbers are shown (see shown below). This information 

is important for linking the rainfall-runoff to the branch. 

 

 

o Now expand the Runoff/groundwater links menu, and select ‘Rainfall-runoff 

links’. This is where the name of the catchment in the rainfall-runoff file is 

defined, and with which branch it is linked.  

o Specify the name and area of the catchment the same as what was specified 

in the rainfall-runoff file, namely ‘Y40D’ and 4536 (km2) respectively. Then 

specify the name of the branch as ‘Mazimechopes’, with US. and DS. Chainage 

of 0 and 65311 respectively (see screenshot below). 

 

 

o Now save and close the Tabular View, so that the network view is visible. You’ll 

now notice a thick green line symbolizing the Mazimechopes branch, meaning 

it now has a catchment link to it (see screenshot below). 
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o Insert a boundary condition for chainage ) on the Mazimechopes branch, and 

specify a constant discharge of 0 m3/s. 

o Now close the close the network file (small X), and within the simulation editor, 

specify the location of the result file and set the storing frequency to 1 day. 

o Now click on the Start tab. Notice now that there is an additional model present 

under the Validation status window for the RR parameters (see screenshot 

below). 

  



 

 

o Now run the simulation (MIKE 11 Classic). Examine the results in MIKE View. Note 

the discharge time series just after the confluence (blue line) compare to 

before the confluence (black line), where the effect of the rainfall from the 

catchment contributing to this branch can be seen (see screenshot below). 

 

 

2.3 EXERCISE 1 

1 Using the existing MIKE 11 setup provided (BlueNile.sim11), run the model and examine 

the results in MIKE View. 

2 Run the “BlueNile.sim” model and compare the results in MIKE View with the results 

from “BlueNile.sim11” (especially just downstream of the confluence). 

3 For the “Incomati_demo.sim11” model, edit the HD parameter file by adjusting the 

Global Mannings M number from 13 to 50. Save the HD file, and rerun the simulation 

(remember to change the name of the result file).Now compare the discharge time 

series at a same location downstream from the first run (Mannings M = 13) to this run 

(Mannings M = 50). What do you notice? 

4 Replace the upstream boundary file with the one called 

“Roseres_Dam_Release_reduced.dfs0”. Save and close the boundary file, and rerun 

the simulation.  

5 Repeat the above step, but change the Global Mannings M number back to 13. 

Compare the result to the previous simulation in MIKE View. 
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3. How to Register/Setup MIKE 11 in MIKE 

Operation Workbench 

3.1 INTRODUCTION 

The purpose of this chapter is to learn how to import, or register, a MIKE 11 model setup into 

MIKE Operations. This process is important, as the model needs to be within MIKE Operations 

framework before any further steps can be taken. Now that you have learnt how to create 

and run a simple MIKE 11 model, the next step will be to register this model within the MIKE 

OPERATIONS Workbench application. 

3.2 STEP-BY-STEP: HOW TO REGISTER A SIMPLE MIKE 11 MODEL IN MIKE 

WORKBENCH 

1. Create a “BlueNile” database using a “Database Manager Utility” (Start > All 

Programs > MIKE OPERATIONS 2019/2020 (version may differ) > Database Manager 

Utility 

2. Open MIKE OPERATIONS Workbench from the Start menu (Start > All Programs > 

MIKE OPERATIONS 2019/2020 (version may differ) > MIKE OPERATIONS Workbench 

(see screenshot below). 

  

3. Select the desired connection name from the dropdown list, then enter the 

appropriate login credentials and click on Login (it is assumed that a connection 

has been created beforehand. If not, this will be done for you). See the example 

screenshot below. 



 

 

 

  

4. Once the MIKE Operations Workbench application has opened, click on the 

‘View’ menu at the top left corner of the screen and select ‘Explorers…’. Once the 

Explorer Configuration window opens, select “Scenarios” (See screenshot below). 
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5. Under the Scenarios tab, you’ll notice two folders that have already been created, 

namely ‘Comparison Configuration’ and ‘Model Setups’. Right-click on the ‘Model 

Setups’ folder and select Create group, then give the new folder a name, for 

example ‘BlueNile. Now right-click on the newly created folder and create another 

one, for example ‘BlueNileEWFFS’ (See screenshot below). 

   

6. Now right click on the second group you created (i.e. ‘BlueNileEWFFS’), and select 

‘Register model’, where a Model Register Wizard window should appear. Click on 

the Select Model Type dropdown and select ‘MIKE11’ (See screenshot below). 

Then click Next. 



 

 

  

7. Take note of the tips that appear in the resulting MIKE 11 model register wizard 

window (see screenshot below). Click Next. 

  

8. Provide a suitable name for your model, then browse to the location of the sim11 

file on your PC, which you created in chapter 2 (See screenshot below). Click Next. 
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9. Depending on the size of the MIKE 11 model configuration, it may take a while for 

it to be imported into MIKE Operations. The next screen will show a summary of 

what files have been registered (See screenshot below). 

 

  

 



 

 

10. The model is now ready to be registered. Click on ‘Prepare for Registration’. Once 

done, there should be a message above the status bar saying ‘Preparation for 

registration Complete’. Now click Finish (See screenshot below). 

  

11. Once the Finish button has been clicked, a Time Series link page will be displayed 

(See screenshot below). This page will also include a summary of the objects within 

the MIKE11 file that you’re registering. Click next. 
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12. On the next Model Register Wizard page, there is an option to create a scenario 

for the MIKE11 model being registered. Leave the settings as the defaults (i.e. as in 

the screenshot below). Click Finish. 



 

 

  

 

13. Once the model registration is complete, a message will pop up in the bottom 

right-hand corner, indicating that the model registration is complete (See 

screenshot below). Additionally, the MIKE11 model will appear as a scenario under 

the folder tree within the Scenario tab in MIKE Operations (See second screenshot 

below). 
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14. If you open the model by right-clicking on the name of the folder (in this case, 

“BlueNile_test”) and selecting Open (or double-clicking on it), an overview of the 

model setup will appear (See example in screenshot below). 

  
  



 

 

3.3 STEP BY STEP: HOW TO SETUP SCENARIOS FOR THE REGISTERED MODEL 

It may be necessary to create several scenarios of the registered models, in this case MIKE 11. 

The simplest way to do this is as follows: 

1. From the previous guide on how to register the MIKE 11, right-click on the model 

in the Scenario tab and select “Clone” (See screenshot below). 

   

2. You will notice that a new scenario appears below the initially registered model, 

called “Clone of…”. Here you can rename the scenario to something more 

appropriate. 

3.4 STEP-BY-STEP: HOW TO RUN SCENARIOS IN MIKE WORKBENCH 

Now that you have learnt how to register a model, as well as cloning an already-registered 

model, the next step is learning how to run a simulation from within MIKE Workbench. 

1. Open the model that was initially registered (if it is not open already). The top screen 

shows the geographical layout of the network file for the MIKE11 model, and below it 

is a summary of data within the model. 

2. Double click on the folder called “Calculation point”. Inside this folder are all the q 

(discharge) and H (water level) points within the MIKE 11 model. For each one of these 

points, there is an output time series.  

3. Select all of these model objects, then right-click and select “Include all output time 

series” > ”Scenario of BlueNile_test” (See screenshot below). 
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4. Go back to the BlueNile_Test folder, and double-click on the “Boundary” folder. 

Include the time series here as input time series to the same model (similar to the step 

done above). 

5. Before the model is run, click on the Time series tab at the bottom of the left panel, 

and expand the “Model and Scenarios” folder as much as possible. You should see 

the boundary files as input data here (similar to the screenshot below). 

   

6. Now right-click on the model that was registered (not the cloned model), and select 

Run Simulation > Foreground (see screenshot below). This will run the MIKE 11 model 

(as we did in chapter 2), but instead of running it within the simulation editor, it is now 

run within MIKE Workbench. 



 

 

  

 

7. While the model is running, a small screen like the one in the left screenshot below will 

appear. Once the model has finished running, a small window at the bottom right-

hand corner will appear showing that the simulation has been completed. 

                                           
          

8. After the model has finished running, you’ll notice a new record appears below the 

scenario model name, called “Simulation of…” and the name of the scenario, with 

the date it was run (see example below). 

  

9. Now go back to the Time series tab, and look for the new folder called “Simulations”. 

Expand this folder as much as possible, until you see all the q and H output time series 

created from the model. Select one of the Qpoint time series and right-click then add 

to new chart (see screenshot below)  
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3.5 EXERCISE 2 

1. Change source of time series at the upstream boundary within MIKE Operations 

Workbench and run different scenarios for SDF2, SDF5, SDF10 and SDF20 (different 

flood return periods). To do this for SDF2, perform these steps: 

o Create a scenario (clone) of the model setup that was imported, and rename 

it (i.e. ‘2yr Scenario of BlueNile_Test’). 

o Now open this scenario (see screenshot below) 

 

 

o At the bottom window, where the summary of the boundary and calculation 

point counts are shown for the scenario, double-click on the Boundary folder.  

o Then double-click on the upstream boundary, namely ‘Blue Nile 

Reach:Eddeim-Kartoum - 0 – OpenSource’.  

o Now select the current time series that has been specified as the upstream 

condition, namely ‘Roseres_Dam_Release.dfs0 - 1 – Roseres’ (see screenshot 

below). 

 

 

o Once this time series has been selected, the properties window (bottom-right 

corner) will show the properties of that boundary. The Source shows that the 

current boundary condition is a Timeseries type, with the name of the time series 

file. Click on the name of the timeseries, then click on the browse button (see 

screenshot below) 
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o When the ‘Timeseries Selector’ window appears, type “Roseres” in the search 

box, then press Enter on the keyboard. [This searches for time series in the 

database with this name]. When the resulting time series appears, select it, then 

click on the Select button (see screenshot below). You’ll notice that there is a 

timeseries called “Roseres” that appears as well. This one will be used in the 

same exercise later on. 

  

o You’ll now notice that the name of the time series in the Properties window 

changes to “Roseres”. Now the upstream boundary condition has been 

changed.  

o Chang the simulations time for the new scenario 



 

 

  

o Now run the scenario (right-click > Run simulation > Foreground. A message 

should appear at the bottom-right corner saying that the simulation is 

complete. 

o Now compare the simulation discharge result from the first scenario  against a 

new the scenario 
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4. How to setup a configuration in MIKE 

Operation 

4.1 INTRODUCTION 

The MIKE Operation platform is a platform that is designed to integrate operation and planning 

tools or models with near-real time, forecasted and historical observed data and the platform 

produce reports from model results and raw and processed data that will assist managers and 

technical personnel to make the required decisions or planning. The platform is for establishing 

customised outputs – generally referred to as decision support systems or information 

management systems - based on standardised functionality. 

The configuration of MIKE OPERATIONS requires relations between GIS feature layers, time series 

and their thresholds in order to present the results. All information is saved in spreadsheets in 

MIKE WORKBENCH. Spreadsheets are maintained in MIKE WORKBENCH but can also be 

changed in the platform. 

The configuration consists of Feature Types. Feature Types are configured from the Application 

Menu of MIKE OPERATIONS. 

4.2 STEP-BY-STEP: HOW TO SETUP THE MIKE OPERATION 

1 Open MIKE OPERATIONS from the Start menu (see screenshot below). 

  

2 Login using the same connection name as the one you were using in Workbench 

(i.e. Training). Once the application has opened, you should see a home page, 

without any data to be seen (example shown below). 



 

 

  

3 Click on the General settings button to the left of ‘Home’ ( ).Click the “New” button 

to create a new configuration. 

4 Specify a name (e.g. “BlueNile_Training”) and click OK (leave the Copy from empty) 

– See screenshot below. 

    

5 Now add the data from the Workbench database. This is done under the General 

box. Select the “BlueNile” as the Model Setup and “Base scenario” as the Forecast 

Scenario (see screenshots below).  
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6 Now we will change the layout to suit us. Leave the Default skin as it is (Office 2013 

Light Grey), but change the Scenario Skin to ‘Sharp’ (see screenshot below). 

  

7 Change the Source Coordinate System to the same as what was used for the MIKE 

11 model, namely WGS 84 UTM 36S. Leave the Views as is (see screenshot below). 

  
  



 

 

Feature Types 

Feature types are the central point of the MIKE OPERATIONS configuration. Feature Types 

contain information about layers to display and specifies relations between Feature Classes, 

observation time series and model input and output. When creating a Feature Type, a new 

tab item is displayed in the application menu, for each active feature type. Here all point 

features, multiline features and polygon features can be configured; specifying thresholds, 

time series and model object references. From MIKE Workbench, it is also possible to edit the 

entire feature type spreadsheets. This will make more sense once a feature type has been 

created. 

1 In the Feature Type list, click the ’New’ button. This will create a new line in the list of 

feature types (see screenshot below). 

 

 

2 Click the ‘Details’ button to enter the details form of the Feature Type. The details 

form shows all properties of the Feature Type. The ‘Active’ checkbox is automatically 

checked. The Active checkbox is used to enable or disable the feature type. 

Disabling the feature type will hide the feature type all over MIKE OPERATIONS. 

3 Give the feature type an Id and Name (see example screenshot below). We will be 

using the BlueNile Basin shapefile for this feature type.  Id is used as a reference in 

spreadsheets. The name is used as display name in MIKE OPERATIONS. Description is 

optional and can contain more lines of text. The description field will be shown in 

tool tips. 
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Layer Types  

The Layer Type, defines the type of layer on the map. 

Static Feature Layer 

Static Feature layers are fixed feature layers placed in the GIS Manager of MIKE Workbench. 

The colours of the static feature layers are determined by the default symbology of the layer 

specified in MIKE Workbench. 

Static Raster Layer 

Static Raster layers are fixed raster’s layers placed in the GIS Manager of MIKE Workbench. 

The colours of the static raster layers are determined by the default symbology of the layer 

specified in MIKE Workbench. 

Dynamic Feature Layer 

Dynamic Feature layers are layers where colours are determined by thresholds setup on each 

feature of the feature class specified. 

Feature Types of this type must have a spreadsheet specified, where information of the feature 

types features can be stored. 

  

Static Feature Layers 

4 Select the Static Feature Layer from the Layer Type dropdown (as seen above). 

Leave the Visibility as the default (i.e. Always). 

Layout 

5 Under the ‘Layout’ section, fill in the following (example screenshot shown below) 

Ribbon Page Name: Overlays 

Group Name:  Catchments 

Ribbon Item Type: Gallery Check Item 

Resource Image Name: Catchment_32 (under the System folder) 

Document Image Path: leave blank 

Theme: leave blank 



 

 

  

GIS 

Feature Class Path is the path to the feature class in the GIS Manager of MIKE Workbench. MIKE 

OPERATIONS supports feature types containing points, without specifying the feature class. This 

is because point features contain coordinates in the spreadsheet. For polygon and line feature 

types, the Feature Class is mandatory. 

6 Click on the browse button in the Feature Class Path, and select Catchments > 

BlueNile catchment boundary (as seen in the screenshot below). 
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7 Now click OK to close the Feature Type Setup window. Once back in the General 

Settings page, click on Save near the top left corner ( ). Now click on the new tab 

called Overlays (which was defined as the ribbon page name). You should see the 

BlueNile Basin in the map view (see screenshot below). 

 

 

 Now that you have learnt how to add a static feature layer, we will add 

a dynamic layer next. 

Dynamic Feature Layers 

1 Within the General Settings page, add a new feature type, and click on Details. 

2 Provide an Id, Name and description (optional). 

3 Leave the Active checkbox ticked, and ensure the layer type is Dynamic Feature 

Class, Always visible (see screenshot below). 



 

 

 .  

4 Click the Create spreadsheet button ( ).  

5 Untick the ‘Create Empty Spreadsheet’ checkbox. 

6 Click on the Feature Class browse button, and under the Stations folder, select Real 

time gauges (see screenshot below) 

  

7 For the Id Attribute and Name Attribute, select “name” for both of them 

8 For Spreadsheet Name, click on the browse button and select the folder called “Real 

time configurations”, then double-click the spreadsheet with the same name (see 

screenshot below). 
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9 Now in the space next to Spreadsheet name, after the second backslash sign, delete 

the words ‘Real time configuration’, and replace them with ‘Discharge’ (see 

screenshot below). Click OK to close the Create Spreadsheet window. 

  

10 Within the Feature Type Setup window, under the Layout section, fill in the fields as 

seen in the screenshot below. 

  

11 For the Feature Class Path in the GIS section, browse for Real time gauges under the 

Stations folder. For Id Attribute name, select ‘name. For Map Label Type, select 

‘Name’. 

For dynamic feature layers, the layer transparency can be specified. The 

transparency can take values in the range 0 to 100. Where 0 is not transparent and 

100 is completely transparent. The default value is -1. This means that for polygon 

layers the layer transparency is set to 60. For line and point layers, the layer 

transparency is set to 0. For static layers, the layer transparency can be set using the 

default symbology of the layer. 

12 Set the Layer Transparency to 0. Click OK (to close the Feature Type Setup window). 

The details for the Dynamic Feature Type have now been specified. Now we need to 

configure the Time Series for this feature type. 

Time series 

1 Click the ‘Time Series’ button of the feature type to configure the time series of the 

feature type. (Click twice - first select then open). 



 

 

2 Click the ‘New’ button twice to add two time series row:   

Name the first one “Observed”, having a “Time Series” Time Series Type and a “Line” as the 

chart type.  Name the second one “Simulated”, having a “Model Output Time Series” type, 

and a “Line” as the chart type (see screenshot below). 

  

3 Click on Details, and make the Id the same as the name (i.e. Observed). Do the same 

for the Simulated one. For the Simulated time series, change the line colour to red and 

the line style to Dash (see screenshot below). Leave all other details as they are. 

  

4 Click OK to close the Time Series Setup window. Now click Save ( ) to save the edits 

for the Dynamic Feature Layer. 

5 Under the General Settings icon at the top-left corner, the ‘Discharge’ icon is now 

visible, which is the Dynamic Feature Layer that was just added. Click on it. You should 

now see a screen similar to the screenshot below. 

  

 This is where the time series associations will be made with the stations. For 

this example, we will only link up an observed and simulated time series for one station. Under 
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the Name column on the left, click on the Id and Name under Identification should now also 

show. 

6 Now on the top right, click the browse button under the Observed category. 

Navigate through the folders to the Input one (input boundary condition at chainage 

0 from MIKE 11) If there is an observed data. 

  

The upstream boundary condition specified in the MIKE 11 model configuration (from chapter 

2) is observed time series data from the Roseres_Dam. Thus, this is the observed time series we 

specify in MIKE Operations. Although the simulated time series will not differ that much, the 

point of this exercise it to demonstrate how to link up observed and simulated time series data 

for the same station in MIKE Operations.  

Next, we will link up the simulated time series data from the MIKE 11 at the q-point closest to 

station Roseres_Dam. 

7 Click on the browse button under the Simulated category, and search for chainage 

number that is closest to the Roseres_Dam. You’ll notice that two result files appear, 

but the QPoint one on top is the one we’re looking for (see screenshot below). Double 

click on it. 

 

 

8 Click on the browse button for Variable, and double-click the only one available.  

9 Provide a suitable label “downstream of Roseres_Dam simulated” 

10 Click Save. 



 

 

 

 

Thresholds 

The thresholds function is an easy way to colour-code time series values in MIKE Operations. In 

this case, we will define thresholds for the discharge values. 

1 In the General Settings view, click on Thresholds for the Discharge dynamic feature 

layer. 

2 Once the Discharge Thresholds window is open, click on New. Here you will need to 

specify a name (Very Low), and a colour (Red) and the size of the symbol (12). Leave 

the symbol as a circle. See an example in the screenshot below.  

  

3 Repeat this for four more thresholds: Low, Medium, High, Very High. See the colours 

for each in the screenshot below. Click Apply then OK when done, then Save within 

the General Settings. 

  

4 Now to assign discharge values to each threshold: click on the Discharge icon below 

General Settings (left of window). Click on the E43 station from the list. Now specify 

the following values for each discharge (for both Simulated and Observed): 

• Very Low:  50 

• Low: 100 

• Medium:  250 
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• High:  500 

• Very High:  900 

See the screenshot below for an idea of how the threshold values should look. 

 

 

5 Click Save once all the threshold values have been assigned. 

Period 

The default period in MIKE Operations is ‘Relative to Now’ (see screenshot below). This time 

period does not coincide with the start and end period from the MIKE11 simulation. The next 

step will be to create an observation period that is in line with the time series from the MIKE11 

setup.  



 

 

 

 

1 Under General Settings, click on Observation Periods ( ).  

2 You will notice that the only one there is the default, “RelativeToNow”. Click on 

‘New’, and call the newly added period “MIKE11_Demo”. Under the Observation 

Period Type, specify “Relative to ToF” from the menu dropdown. 

  

3 Click on Details for the MIKE11_Demo. Make the Id the same as the name, then click 

on the Period tab. 

4 From the Relative to ToF, specify the Relative Period as 90 days Before (see 

screenshot below). Click OK. 
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5 In the Observation Periods window, click Save first, then OK. Then click on Save within 

the General Settings page (you may have to refresh MIKE Operations as well). 

6 Now click on the Home tab, and change the Observation period from ‘Relative to 

Now’, to the one we just created under the Event category, namely 

“MIKE11_Demo”, and click on the date next to the ToF to the right (see screenshot 

below). The date on the map view will now change to what we specified for this 

observation period. 

  

7 Click on the Forecasting tab and click on the ‘Discharge’ icon. 

8 Now click on the station called Rosiers dam on the left of the screen. You should see 

the observed and simulated time series for this station (blue solid line and red dashed 

lines respectively), as you can see in the screenshot below. The station in the map 

view becomes highlighted with a blue circle around. You can now see the 

thresholds within the chart view, along with how the dot for the station in the map 

changes, depending on the discharge value. 
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4.3 EXERCISE 3 

1 Add the ‘Rivers’ shapefile as a static layer into MIKE OPERATIONS. 

2 Link the Observed time series for stations in MIKE OPERATIONS. 

3 Add a dynamic feature class, using the shapefile called “BlueNile Dummy Gauges”. 

Then link the simulated discharge time series for these locations. Furthermore, create 

discharge thresholds (similar to the one earlier, or create your own). 

 

  



 

 

5. EASTER NILE EWFFS 

5.1 INTRODUCTION 

The fundamental purpose of the BlueNile Early Warning Flood Forecasting System (EWFFS) is to 

predict floods using near real-time and forecasted data to low-lying areas, which are 

susceptible to flood risk within the BlueNile basin. This chapter will guide you through the actual 

BlueNile Basin model and MIKE Operations configuration (rather than the one you created 

earlier) and how this has been configured.  

5.2 MIKE 11 BLUENILE SETUP 

As explained in chapter 2, the core of MIKE 11 is the hydrodynamic (HD) module, used to 

convey water within the river channels. However, in MIKE 11, it is possible to include additional 

modules to the HD for particular simulations. One of these is the MIKE 11 Rainfall-Runoff module, 

which coupled with the HD module forms the basis of the hydrological model. This section will 

explain how the MIKE 11 was configured for the BlueNile EWFFS. 

5.2.1 Forecast Model 

A combined hydrological - hydrodynamic MIKE11 model has been developed for the BlueNile 

Basin. This includes a NAM model for the entire basin, which is used to estimate the runoff to 

the BlueNile floodplain. This section provides an overview of the models and data used. 

In the operational real-time flood forecasting setup, the following editors are run: 

• Hydrodynamic (HD) 

• Rainfall-Runoff (RR) 

• Data Assimilation (DA); 

with the HD calculations based on hydrodynamic flow conditions. 

Hydrodynamic (HD) 

As explained in chapter 1, the fundamental components of the MIKE 11 setup are the network, 

cross-section, boundary condition and HD parameter files. These were all included in detail 

within the BlueNile EWFFS configuration. The figure below shows the network layout of all the 

rivers in the MIKE 11-NAM model for the BlueNile EWFFS. The blue boxes in this figure represent 

the boundary positions in the model, including all the upstream points of each river branch, 

and the outlet boundary at bottom of the BlueNile River.  

  

 



 

73 | P a g e  

 

  

Cross-sections in the cross section file were derived from various datasets: surveyed cross-

sections, 24 meter AIRBUS DEM. The surveyed cross-section covers the downstream od BlueNile 

river beyond the border of Ethiopia and Sudan.  The upstream of the BlueNile River cross-

sections are derviced from 24 meter AIRBUS DEM.. 

The simulated streamflow from the NAM Rainfall-runoff model were used as boundary files for 

all the upstream ends of the branches that required boundary files. 

For the hydrodynamic parameter file, the main parameter specified was bed resistance. A 

uniform Manning’s M value of 15 was used for the river bed, where M is a reciprocal of n.  

  

Rainfall-Runoff (RR) 

A Rainfall-runoff hydrological model is one of the primary components of a EWFFS, to predict 

or forecast flows based on real-time or forecasted rainfall data. Rainfall-runoff models are 

setup to simulate the streamflow of catchments, by conceptualising the physical aspects of 

the catchment (e.g. soil profile, topography, land cover/use). The NAM rainfall-runoff model 

was chosen for this study, for its suitability to flood forecasting systems.  

NAM is the Danish abbreviation of “Nedbør-Afstrømnings-Model” which translates into English 

as “Rainfall-Runoff Model”. NAM simulates the terrestrial phase of the hydrological cycle. The 

NAM model can be applied independently or it can be used to generate boundary 

contributions to a river network model (as for the BlueNile EWFFS). In this way, it is possible to 



 

 

model an individual catchment as well as a group of sub-catchments contributing to a larger 

basin with a more complex river network. The NAM Rainfall-runoff model has a hot-start 

capability, which is a fundamental requirement for near real-time systems. Hot-start is the ability 

of the model to save the state variables from previous simulations to be used in simulations in 

the near future. 

The NAM model requires the following input data: 

o Model parameters which describe the hydrological characteristics of the 

catchment 

o Boundary conditions (e.g. catchments) 

o Meteorological data 

o Rainfall 

o Potential evaporation 

o Streamflow data for calibration and verification purposes 

The meteorological data are input into the model as continuous time series. The temporal 

resolution (i.e. the time-step) of the data is very important. This is especially important for 

precipitation data, which must have a sufficiently fine temporal resolution, in order to obtain 

accurate results. For this reason daily precipitation data is the minimum temporal resolution 

that should be used. With evapotranspiration data, if daily data is not available, it is sufficient 

to utilize daily averages based on monthly values.  

Sub-catchments that were delineated from the 24 meters AIRBUS DEM for the BlueNile River 

basin were used for the NAM Rainfall-runoff modelling of this project. The catchment spatial 

scale was sufficient for the purpose of the project. Furthermore, the required meteorological 

data, specifically evaporation, is available per sub-catchment. Parameters are required for 

each sub-catchment included in the model. Initial model parameters are estimated based on 

soil and land use characteristics of the catchment.  The parameters are then further refined 

during a manual calibration process. 

Data Assimilation (DA) 

Data assimilation is a technique for combining any measurements of the state of the system 

with the model dynamics, in order to improve the knowledge of the system. The data 

assimilation module in MIKE 11 can be used for assimilation of water level and discharge 

measurements in the hydrodynamic model. Furthermore, the data assimilation module can be 

used for uncertainty assessment and estimation of model prediction uncertainties. 

5.3 BLUENILE MIKE 11 SETUP ON MIKE OPERATION WORKBENCH 

The Rainfall-runoff and hydrodynamic model, in this case the BlueNile Basin MIKE 11 NAM 

Rainfall-runoff setup, was registered and imported to the central database and set up to run 

from the platform. Here, the input time series is updated regularly using the real-time and 

forecasted data. The BlueNile MIKE 11 NAM Rainfall-runoff model was configured to run every 

6 hours. Once the model run/simulation has been completed, results are summarised to be 

analysed on the MIKE Operation User Interface and the BlueNile basin web portal. If simulated 

or observed streamflow values exceed the pre-defined threshold values, warning triggers are 

sent to the appropriate bodies by SMS or Email. 
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The MIKE 11 NAM Rainfall-runoff model that was registered and imported into the MIKE 

Operation platform through a “Scenario Manger”, is shown below. Scenarios are defined in 

the platform, where all the input time series that are expected to be updated by the near real-

time and forecasted information, are linked to appropriate timeserie/s in the model. In some 

cases, where the input timeseries are required to be built from more than one source (for 

example, combining observed and forecast rainfall into one timeseries), a hierarchy tool in the 

“Scenario manager” is used to build the input timeseries. 

  

 

5.4 BLUENILE EWFFS ON MIKE OPERATION UI 

A simplified user interface which enables everyday users to configure specific elements within 

the model and to maintain the system has been developed. This is the “MIKE Operation Real-

Time User Interface”. It is quick and easy to teach potential users to operate the system 

effectively and thus ensures that system operators can effectively run and maintain the system. 

It is designed to display real-time data, model time series input and model simulation results 

linked to spatial features. An example of how the BlueNile EWFFS looks in MIKE Operations is 

shown below. 



 

 

 

 

 

5.5 BLUENILE EWFFS WEBSITE 

The BlueNile Web portal is a replica of the BlueNile basin EWFFS desktop user interface. The 

web portal displays all information that is included in the desktop user interface. An example 

of how the EWFFS website looks can be found at the following url: 

http://bluenileffs.ekodata.co.za. A screenshot from this website is provided below. 

 

 

http://bluenileffs.ekodata.co.za/

